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I. [bookmark: _Toc241489292]개요
Windows7을 도입 시 기존의 응용 프로그램에 대한 호환성은 중요한 고려 사항입니다. 
Windows Application Compatibility 도구는 이러한 호환성에 대한 문제를 해결해주는 중요한 도구입니다. Application Fixes를 적용함으로 특정 응용 프로그램과 윈도우의 동작 방식을 변경할 수 있으며, 호환성에 대한 문제를 해결할 수 있습니다. 

Windows에서Shim은 응용 프로그램과 Windows 플랫폼 사이에 존재하여, Windows나 응용 프로그램이 상호 호환되지 않는 호출이나 기능을 사용할 경우, 이를 대신 처리 혹은 리다이렉션 시켜 상호간의 동작이 문제없게 만들어주는 중간자 역할을 하게 됩니다.

[image: ]
Shim을 통한 호환성 장애를 해결하기 위해서는 어느 Shim을 사용하는 지와 어떻게 설정하는지 정도의 방법만 알고 있으면 호환성 관련 문제를 해결할 수 있습니다. 
이 가이드는 Stock Viewer 데모 응용 프로그램을 이용해서 어떤 Shim을 사용해야 하는지, 어떻게 구성하는지에 대해서 살펴 봅니다. 
사전 준비 사항
데모를 진행하기 위해서는 다음과 같은 준비가 필요합니다.
	
	필요 준비 사항
	비고

	1
	Windows7 
	평가판 다운로드 사이트 
http://technet.microsoft.com/ko-kr/evalcenter/cc442495.aspx

	2
	Stock Viewer Demo Application
	다운로드 사이트
http://blogs.msdn.com/cjacks/attachment/6972990.aspx

	3
	Microsoft Application Compatibility Toolkit 5.5
	현재 배포되는 버전은 5.5 버전이며, 64비트 운영체제를 지원하지 않습니다. 64비트를 지원하는 버전은 6.0 버전으로 곧 릴리즈 될 예정입니다. 현재 버전의 ACT를 다운 받기 위해서는 아래 사이트를 참고 합니다. 
http://www.microsoft.com/downloads/details.aspx?FamilyId=24DA89E9-B581-47B0-B45E-492DD6DA2971&displaylang=en




II. [bookmark: _Toc241489293]ACT도구를 이용한 호환성 장애 해결
호환성 문제를 해결하기 위해서는 장애에 대한 파악, 적절한 Shim 적용, 생성된 사용자 정의 Shim Database를 사용자에게 배포함으로써 호환성 관련 문제를 해결합니다. 

이 장에서는 프로그램의 호환성 문제를 확인하고 이를 해결하기 위해 Shim을 생성하는 방법과 Custom Shim Databases를 사용자 배포하여 호환성 문제를 해결하는 전반적인 과정에 대해서 소개합니다.

[bookmark: _Toc241489294]Stock Viewer를 통한 에러 확인
호환성 관련 문제를 해결하기 위해서는 먼저 일반적으로 발생되는 호환성 관련 에러를 확인 합니다. Stock Viewer은 응용프로그램의 호환성 문제 해결을 위해서 일반적으로 Windows7에서 발생되는 다양한 호환성 관련 문제를 보여주기 위한 데모 응용 프로그램입니다. 

먼저 이 도구를 실행해서 호환성 관련 장애를 확인 합니다. 
1. 다운 받은 StockViewer 프로그램을 설치합니다. 설치는 기본값을 그대로 사용합니다. 
2. 시작>모든 프로그램>Stock Viewer>Stock Viewer를 클릭하여 프로그램을 실행합니다. 
[image: ]
3. Stock Viewer를 실행하면 다음과 같이 “응용 프로그램이 관리자 권한을 가지고 있어야 한다”는 에러 메시지가 나타납니다.
[image: ]
에러 메시지에서 “확인” 버튼을 클릭하면 프로그램이 실행됩니다.
주의: 프로그램이 로딩되는데 다소 시간이 걸리므로 프로그램이 로딩될 때 까지 기다립니다. 
4. 프로그램이 로딩되면 메뉴 항목에서 “Trends”를 클릭합니다. 
[image: ]
5. 다음과 같이 “Object 생성 에러” 메시지가 나타납니다.메시지 내용을 확인 후에 “확인”을 클릭합니다. 
[image: ]
6. 상단의 메뉴 항목에서 Tools> Options를 차례대로 클릭합니다.
[image: ]
7. 다음과 같이 레지스트리 관련 에러 메시지가 나타납니다.“계속” 버튼을 클릭합니다 
[image: ]
8. 상단의 메뉴에서 Help> Check for Updates를 차례대로 클릭합니다. 
[image: ]
9. 다음과 같이 예외처리 관련 에러 메시지가 나타납니다.“계속” 버튼을 클릭합니다.
[image: ]
10. Stock Viewer의 프로그램을 종료합니다.프로그램 호환성 관리자 창이 뜨면 닫기를 클릭합니다. 

[bookmark: _Toc241489295]프로그램 호환성 관리자를 통한 호환성 문제 해결
지금까지 Stock Viewer 프로그램의 몇 가지 호환성 관련 장애에 대해서 살펴 보았습니다.
장애가 발생한 프로그램을 종료하면 다음과 같이 프로그램 호환성 관리자 나타납니다.
[image: \\192.168.1.250\d$\이경민\사용자 지정 1.png]
이 기능은 Windows7 에서 기본으로 제공하는 기능으로 응용 프로그램을 Windows7 환경에서 실행 시 발생되는 문제점을 확인하고 이에 대한 Application Fix를 자동으로 적용해서 동일한 문제가 발생되지 않도록 합니다. 관리자나 사용자가 호환성 관련한 문제 해결을 하지 않아도 되기 때문에 대단히 유용한 도구라고 할 수 있습니다. 

그러면 프로그램 호환성 관리자가 적용한 Application Fixes 항목을 확인합니다. 
1. regedit.exe을 실행 한 다음, 다음의 경로를 탐색합니다. 
검색 경로: HKEY_CURRENT_USER\Software\Microsoft\WindowsNT
\Current Version\AppCompatFlags\Layers
[image: ]
2. Layer 하위의 항목 다음의 문자열을 확인합니다. 
A. 이  름 : c:\Program Files\StockViewer\StockViewer.exe
B. 데이터 : ELEVATECREATEPROCESS
3. StockViewer 응용 프로그램을 관리자 권한으로 실행하면 프로그램을 실행합니다. 
앞에서 발생하던 장애가 더 이상 발생하지 않습니다. 

Windows7에서 기본 제공하는 프로그램 호환성 관리자는 자동으로 호환성에 대한 에러를 확인하고 Application Fixes를 자동으로 설정함으로써 호환성에 대한 문제점을 해결해 줍니다.

[bookmark: _Toc241489296]Standard User Analyzer (SUA)
Windows7은 Windows Vista와 마찬가지로 UAC를 사용하고 있습니다. 사용자가 로컬 관리자 권한을 가지고 있어도 기본적으로는 일반 사용자 권한으로 프로그램을 실행하기 때문에, 이전 버전에서 개발된 응용 프로그램이 정상적으로 동작하지 않을 수 있습니다. 
Standard User Analyzer (SUA) 도구는 일반 사용자(LUA)모드로 응용 프로그램을 실행하여, 일반 사용자 권한을 가진 상태에서 발생하는 호환성 문제를 찾아주는 분석 프로그램입니다.
아래 그림은 Standard User Analyzer를 통한 호환성 장애에 대한 장애를 해결하는 방법을 보여 줍니다. 
[image: Standard User Analyzer workflow process]
[bookmark: _Toc239596072]
Standard User Analyzer를 사용해서 호환성에 대한 문제를 해결하는 방법은 다음과 같습니다.
1. Standard User Analyzer을 실행합니다.
[image: ]
2. Target Application에 Stock Viewer 프로그램을 선택합니다.
3. Symbols Path에 다음과 같이 입력합니다. 
srv*c:\symbols\pri*\\symbos\symbols;SRV*c:\symbos\pub*http://msdl.microsoft.com/download/symbols
Launch 버튼을 클릭합니다. 
[image: ]
4. Stock Viewer 프로그램이 실행됩니다. 프로그램이 실행되면, 앞에서 수행한 테스트를 동일하게 수행 후 종료합니다.
[image: ]
5. Standard User Analyzer 수행 결과가 나타납니다.Stock Viewer의 프로그램을 종료하면 위와 같이 문제가 발생한 부분을 알려줍니다.
[image: ]	
6. 메뉴에서 Mitigation> Apply Mitigations을 선택합니다.
[image: ]
7. Apply 버튼을 클릭합니다.
Apply 버튼을 클릭하면 Standard User Analyze는 custom shim database를 생성하여 현재 시스템에 적용됩니다. 해당 응용 프로그램의 문제 이러한 시뮬레이션을 통해 해결할 수 있는지를 확인할 수 있습니다.

[bookmark: _Toc241489297]Compatibility Administrator
Compatibility Administrator 도구는 Windows7을 조직에 배포하기 전에 잠재적인 호환성 이슈를 파악한 후에 발견된 호환성 문제에 대해서 문제 해결을 위한 Shim을 선택하고 Shim Database를 생성하여 이를 배포하기 위해서 제공되는 도구입니다. 

Compatibility Administrator 통해서 Shim을 생성하고 배포하는 방법은 다음과 같습니다. 
1. 시작>Microsoft Application Compatibility Toolkit 5.5>Compatibility Administrator를 차례대로 클릭합니다. 
[image: ]
2. Custom Databases 하단의 New Database(1) [Untitled_1]를 선택한 다음, Create New> Application Fix…을 클릭합니다.
[image: ]
3. Program file location에 다음과 같이 설정합니다. 
[image: ]
A. Name of the program to be fixed: StockViewer
B. Name of the vendor for this program: FreeMDemos
C. Program file location: 
C:\Program Files\StockViewer\StockViewer.exe
4. Compatibility Modes을 선택합니다.Compatibility Modes에서 None을 선택하고
“다음”버튼을 클릭합니다.
[image: ]
5. Compatibility Fixes을 선택합니다.Compatibility Fixes 중에Standard User Analyzer 도구의 Apply Mitigations 항목을 참고하여 선택합니다.
[image: ]
6. Matching Information이 항목을 확인 합니다. 
[image: ]
7. Save 버튼을 클릭합니다.
[image: ]
8. 생성한 Shim Database에 적절한 이름을 부여합니다. 
[image: ]
9. 저장할 위치를 선택한 다음, 파일을 저장합니다.

[bookmark: _Toc241489298]Shim 배포
생성한 Shim Database를 해당 응용 프로그램을 사용할 컴퓨터에 배포합니다. 윈도우 7 에서는 SDB를 설치하는데 필요한 유틸리티인 sdbinst.exe를 기본적으로 내장하고 있어, 이 유틸리티를 이용한 배치 파일(*.bat) 파일을 생성하여 배포하게 됩니다. 
sdbinst.exe의 도움말은 CMD 창에서 sdbinst.exe -?을 입력하면 보다 상세한 구문에 대해서 확인 할 수 있습니다. 
[image: ]

Custom Shim Databases 배포 하기 위한 bat 파일 생성은 다음과 같습니다. 	
1. Notepad에 다음과 같이 입력합니다. 
sdbinst "\\ServerName\SDBShare\FreeMDemos.sdb" -q
뒤에 “저장한SDB파일이름.sdb”는 위에서 저장한 Custom Shim Database명입니다.
[image: ]
2. 파일을 SDB.bat파일을 저장한 다음, 공유 폴더를 생성하고, 위의 SDB 파일과 BAT 파일을 공유합니다. 

사용자는 공유폴더에서 다음의 파일을 복사 또는 .bat 파일을 실행하여 shim database를 자신의 컴퓨터에 설치함으로써 호환성에 대한 문제를 해결합니다. 
[image: ]


III. [bookmark: _Toc241489299]다양한 호환성 장애에 대한 해결 방법
이번 장에서는 StockViewer 데모 응용 프로그램을 이용해서 다양한 호환성 관련 장애를 살펴보고 이를 해결하는 방법에 대해서 살펴 봅니다. 

[bookmark: _Toc241489300]실행 권한 승격
기존의 응용 프로그램을 실행 시 권한 승격에 대한 장애가 발생할 수 있습니다. Shim을 이용해 이러한 권한 승격에 대한 장애를 해결합니다. 승격에 대한 장애를 확인한 다음, 이러한 장애를 해결하기 위해 앞에서 생성한 SDB 파일에 추가합니다. 

1. StockViewer 응용 프로그램을 실행한 다음, 상단 메뉴 중 “Order”를 클릭합니다. 
[image: ]
2. 태스크 바에 새로운 아이콘이 깜빡 거리며 추가됨을 확인 합니다. 이 때 이 태스크 바의 아이콘을 클릭하면, UAC 창이 뜨게 됩니다. UAC 창에서 확인을 클릭하면 아래와 같이 Update Order 창이 뜨게 됩니다. 
[image: ]
여기서 중요한 점은 UAC 창이 바로 뜨는 것이 아니라, 프로그램 뒤에 숨어 있다는 점입니다. 사용자가 태스크 바의 아이콘을 클릭해야 UAC 창을 볼 수 있습니다. 
3. 제어판> Stock Viewer Setting 메뉴를 클릭합니다. 
[image: ]
4. 그러면 권한과 관련된 다음 에러 창이 표시됩니다.
[image: ]

관리자 권한이 필요한 경우 바로 UAC 창이 뜨지 않고, 클릭이 있어야 하는 점, 그리고 사용자가사용자가 설치된 프로그램의 설정을 바꾸고자 하는 경우 권한 승격이 필요로 하는 문제점이 발생하고 있습니다. 이러한 문제점을 Shim을 통해서 해결합니다. 
1. 시작>Microsoft Application Compatibility Toolkit 5.5>Compatibility Administrator를 차례대로 클릭합니다. .
[image: ]
2. 이전에 생성한 “FreeMDemos.sdb”파일을 연 다음, 아래 그림과 같이 “Fix” 메뉴를 클릭합니다. 
[image: ]
3. “Create new Application Fix”창에서 다음과 같이 입력한 다음, “다음”을 클릭합니다. 
[image: ]
A. Name of the program to be fixed: StockViewerUpdateOrders
B. Name of the vendor for this program: StockViewerUpdateOrders
C. Program file location: 
C:\Program Files\StockViewer\StockViewerUpdateOrders.exe
4. Compatibility Modes 창에서 Compatibility Modes에서 None을 선택하고
“다음” 버튼을 클릭합니다.
[image: ]
5. Compatibility Fixes 창에서 “SpecificNonInstaller”를 선택합니다. “다음”을 클릭합니다. 
[image: ]
6. Matching Information 창에서 설정 항목을 확인 합니다. “마침”을 클릭합니다. 
[image: ]
이와 같이 Shim을 추가함으로써 UAC 창이 바로 보이지 않는 문제를 해결할 수 있습니다. 

위와 같은 방식으로 Stock Viewer Setting 도구의 사용자 권한 승격에 대한 Shim을 추가합니다. 
1. Compatibility Administrator 도구에서 아래 그림과 같이 “Fix” 메뉴를 클릭합니다. 
[image: ]
2. “Create new Application Fix”창에서 다음과 같이 입력한 다음, “다음”을 클릭합니다. 
[image: ]
A. Name of the program to be fixed: StockViewerControlPanel
B. Name of the vendor for this program: StockViewerControlPanel
C. Program file location: 
C:\Program Files\StockViewer\SStockViewerControlPanel.exe
3. Compatibility Modes 창에서 Compatibility Modes에서 None을 선택하고
“다음” 버튼을 클릭합니다.
[image: ]
4. Compatibility Fixes 창에서 “RunAsAdmin”을 선택합니다. “다음”을 클릭합니다
[image: ]
5. Matching Information 창에서 설정 항목을 확인 합니다. “마침”을 클릭합니다
[image: ]
6. Database 생성이 완료되었으면 설치 메뉴를 통해서 sdb를 설치합니다. 
[image: ]
7. 설치 후에 StockViewer 응용 프로그램을 실행하면 앞에서 발생한 에러가 더 이상 발생되지 않음을 확인 합니다. 
그런데, “Order”메뉴를 클릭하면 다음과 같은 에러가 발생합니다. 
[image: ]
이 에러에 대해서는 다음 과정에서 해결합니다. 
8. 제어판> Stock Viewer Setting 메뉴를 클릭합니다. UAC 창에서 확인을 클릭하면 다음 그림과 같이 설정 화면이 실행됨을 확인 할 수 있습니다. 
[image: ]
이상으로 StockViewer 실행 시 권한 승격에 대한 문제를 Shim을 통해서 해결하는 방법에 대해서 살펴 보았습니다. 
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다양한 UAC Application Fixes
응용 프로그램에 대한 다양한 호환성 문제 중에서 다양한 UAC 관련 장애를 해결하기 위한 Shim 생성에 대해서 좀 더 자세히 살펴 봅니다. 
	실습을 위한 준비 사항

	다양한 UAC Application Fixes를 적용하기 위해 앞에서 설치한 SDB를 제거하는 작업을 우선 수행합니다. 
제거하는 방법은 다음과 같습니다. 
1. 기존에 설치된 SDB를 삭제합니다. 
[image: ]
2. 제거 확인 창이 뜨면 “확인”을 클릭합니다. 
[image: ]
3. FreeMDemos.sdb 파일에서 StockViewerUpdateOrders를 선택한 다음, “Delete”를 선택합니다. 
[image: ]
4. StockViewerUpdateOrders가 제거된 후에 다시 설치합니다. 
[image: ]



앞에서 살펴본 “Order”메뉴를 선택하거나, 제어판의 StockViewer Settings를 클릭할 때 UAC 팝업 창이 더 이상 뜨지 않도록 Shim을 생성하는 방법에 대해서 살펴 봅니다. 
1. 이전에 생성한 “FreeMDemos.sdb”파일을 연 다음, 아래 그림과 같이 “Edit Application Fix” 메뉴를 클릭합니다.
[image: ]
2. Program Information 창에서 “다음”을 클릭합니다. 
[image: ]
3. Compatibility Modes 창에서 “다음”을 클릭합니다.
[image: ]
4. Compatibility Fixes 창에서 “CorrectShellExecuteHWND”를 추가 한 후에 “다음”을 클릭합니다. 
[image: ]
5. Matching Information 창에서 “마침”을 클릭합니다. 
[image: ]
6. 수정된 SDB 파일을 저장한 다음, 설치합니다. 
[image: ]
9. 앞에서 삭제한 StockViewerUpdateOrders를 다시 추가 한 다음, SDB 파일을 저장하고 설치 합니다. 
프로그램을 실행해서 더 이상 UAC 창이 뜨지 않음을 확인 합니다. 
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Virtual Registry
Virtual Registry는 기존의 응용 프로그램이 특정 레지스트리에 직접 레지스트리를 생성하거나 업데이트 하는 경우 발생되는 호환성 장애에 대해서 VirtualRegistry는 이전 응용 프로그램을 위한 다양한 용도의 Shim입니다. 
레지스트리의 특정 영역의 레지스트리 키에 대한 리다이렉션이나, 응용 프로그램이 존재하지 않는 특정 레지스트리 키에 접근하고자 할 때 다른 레지스트리 값을 제공해 주거나 하드코딩 된 버전이 있을 때 다른 버전을 제공해 주는 등의 기능을 제공합니다.

Virtual Registry Shim을 활용하는 방법에 대해서 살펴 봅니다. 
1. StockViewer 응용 프로그램을 실행 한 다음, 메뉴 항목에서 “Browse” 를 클릭합니다. 
IE6 버전이 필요하다는 에러 메시지를 확인 합니다. 
[image: ]
2. 프로세스 모니터를 실행해서 레지스트리 키를 확인 할 수 있습니다. 
[image: ]
3. 이전에 생성한 “FreeMDemos.sdb”파일을 연 다음, 아래 그림과 같이 “Edit Application Fix” 메뉴를 클릭합니다.
[image: ]
4. Program Information 창에서 “다음”을 클릭합니다. 
[image: ]
5. Compatibility Modes 창에서 “다음”을 클릭합니다.
[image: ]
6. Compatibility Fixes 창에서 “VirtualRegistry”를 추가 합니다. 
[image: ]
7. “VirtualRegistry”를 선택한 후에 “Parameters”를 클릭합니다. Command line 항목에 “IE60”이라고 입력합니다. “OK”를 클릭합니다. 
[image: ]
8. Matching Information 창에서 “마침”을 클릭합니다. 
[image: ]
9. 수정된 SDB 파일을 저장한 다음, 설치합니다. 
[image: ]
10. 메뉴 항목에서 “Browse” 를 클릭하면, Windows7의 기본 IE 8.0이 정상적으로 로딩되는 것을 확인합니다. 
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CorrectFilePaths
CorrectFilePaths는 매우 유연한 Shim으로 기존의 응용 프로그램이 파일 경로를 하드 코딩 한 경우, 기본 파일 위치를 리다이렉션 하는 기능을 제공합니다. 또한 특정 경로를 다른 경로로 설정할 수도 있습니다.
CorrectFilePaths를 활용하는 방법에 대해서 살펴 봅니다.
1. StockViewer 응용 프로그램을 실행 한 다음, 메뉴 항목에서 “Option>Save Preferences” 를 클릭합니다.
[image: ]
2. 다음과 같이 액세스 거부 에러 메시지를 확인 합니다. “끝내기”를 클릭합니다. 
[image: ]

3. 이전에 생성한 “FreeMDemos.sdb”파일을 연 다음, 아래 그림과 같이 “Edit Application Fix” 메뉴를 클릭합니다.
[image: ]
4. Program Information 창에서 “다음”을 클릭합니다. 
[image: ]
5. Compatibility Modes 창에서 “다음”을 클릭합니다.
[image: ]
6. Compatibility Fixes 창에서 “CorrectFilePaths”를 추가 합니다.  
[image: ]
7. “CorrectFilePaths”를 선택한 후에 “Parameters”를 클릭합니다. Command line 항목에 다음과 같이 입력합니다. 
“C:\Windows\Downloaded Program Files\StockViewer.ini;%userappdata%\StockViewer.ini”
“OK”를 클릭합니다. 
[image: ]
8. Matching Information 창에서 “마침”을 클릭합니다. 
[image: ]
9. 수정된 SDB 파일을 저장한 다음, 설치합니다. 
[image: ]
10. 메뉴 항목에서 ““Option>Save Preferences” 를 클릭하면, 정상적으로 동작하는 것을 확인 합니다. 
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User Interface Process Isolation
User Interface Process Isolation (UIPI)는 낮은 레벨의 권한을 가진 프로세스가 높은 레벨의 권한을 가진 프로세스에게 윈도우 메시지를 보낼 때 이를 보호하거나 격리 시키는 역할을 수행합니다. 특정 메시지에 대해서 이를 허용하도록 설정하는 Shim을 제공합니다.

User Interface Process Isolation를 위한 Shim을 활용하는 방법에 대해서 살펴 봅니다.
1. StockViewer 응용 프로그램을 실행 한 다음, 메뉴 항목에서 “Help>Check for Updates” 를 클릭합니다.
[image: ]
2. 다음과 같이 액세스 거부 에러 메시지를 확인 합니다. “끝내기”를 클릭합니다. 
[image: ]

3. Compatibility Administrator 도구에서 아래 그림과 같이 “Fix” 메뉴를 클릭합니다. 
[image: ]
4. “Create new Application Fix”창에서 다음과 같이 입력한 다음, “다음”을 클릭합니다. 
[image: ]
· Name of the program to be fixed: StockViewerUpdater
· Name of the vendor for this program: StockViewerUpdater
· Program file location: 
C:\Program Files\StockViewer\StockViewerUpdater.exe
5. Compatibility Modes 창에서 Compatibility Modes에서 None을 선택하고, “다음” 버튼을 클릭합니다.
[image: ]
6. Compatibility Fixes 창에서 “RunAsAdmin”을 선택합니다. “다음”을 클릭합니다
[image: ]
7. Parameters 항목을 클릭한 후에 다음과 같이 입력합니다. 
[image: ]
8. Matching Information 창에서 설정 항목을 확인 합니다. “마침”을 클릭합니다
[image: ]
9. Database 생성이 완료되었으면 저장 후, 설치 메뉴를 통해서 sdb를 설치합니다. 
[image: ]
10. 메뉴 항목에서 ““1” 를 클릭하면, 정상적으로 동작하는 것을 확인 합니다. 
[image: ]

[bookmark: _Toc241489305]

Windows Resource Protection
Windows Resource Protection는 중요한 운영체제 파일과 레지스트리 설정 값을 사용자의 수정으로부터 보호하는 기능입니다 중요한 운영체제 파일에 대한 업데이트 혹은 쓰기를 시도하는 응용 프로그램과 인스톨러에 대한 호환성을 보장하고, "Access Denied"를 리턴하지 않기 위해서 WRPMitigation Shim을 제공합니다. 
이 Shim은 보호되는 이러한 파일에 대한 쓰기 시도 시 실제 위치를 변경하는 기능을 제공하는데, 응용 프로그램이 쓰기를 시도하지만 실제 파일에 대해서는 업데이트가 발생되지 않게 됩니다.

Windows Resource Protection를 위한 Shim을 활용하는 방법에 대해서 살펴 봅니다.
1. StockViewer 응용 프로그램을 실행 한 다음, 메뉴 항목에서 “File>Update Kernel”을 클릭합니다.
[image: ]
2. 다음과 같이 액세스 거부 메시지 창이 뜹니다. “끝내기”를 클릭합니다. 
[image: ]
3. 이전에 생성한 “FreeMDemos.sdb”파일을 연 다음, 아래 그림과 같이 “Edit Application Fix” 메뉴를 클릭합니다.
[image: ]
4. Program Information 창에서 “다음”을 클릭합니다. 
[image: ]
5. Compatibility Modes 창에서 “다음”을 클릭합니다.
[image: ]
6. Compatibility Fixes 창에서 “WRPMitigation”를 추가 합니다.  
[image: ]

7. Matching Information 창에서 “마침”을 클릭합니다. 
[image: ]
8. 수정된 SDB 파일을 저장한 다음, 설치합니다. 
[image: ]
9. 메뉴 항목에서 “File>Update Kernel”” 를 클릭하면, 정상적으로 동작하는 것을 확인 합니다. 
[image: ]
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Version Lies
일반적인 응용 프로그램 호환성 이슈는 응용 프로그램이 운영체제의 버전을 체크할 때 입니다. 
다음과 같이 dwMajorVersion 버전을 > 혹은 = 으로 체크를 하게 됩니다. 
	if ( osvi.dwMajorVersion == 6 && osvi.dwMinorVersion == 1 ) 
{ if( osvi.wProductType == VER_NT_WORKSTATION ) 
StringCchCat(pszOS, BUFSIZE, TEXT("Windows 7 ")); 
else StringCchCat(pszOS, BUFSIZE, TEXT("Windows Server 2008 R2 " )); }


이러한 운영 체제 버전에 대한 호환성 체크를 해결하기 위해서 Version Lie를 위한 Shim을 제공합니다. 

Version Lies Shim을 활용하는 방법에 대해서 살펴 봅니다.
1. StockViewer 응용 프로그램을 실행 한 다음, 메뉴 항목에서 “Option>Show me a Star” 를 클릭합니다.
[image: ]
2. 다음과 같이 운영 체제 버전에 대한 에러 메시지를 확인 합니다. “확인”를 클릭합니다. 
[image: ]
3. Compatibility Administrator 도구에서 아래 그림과 같이 “Fix” 메뉴를 클릭합니다. 
[image: ]
4. “Create new Application Fix”창에서 다음과 같이 입력한 다음, “다음”을 클릭합니다. 
[image: ]
· Name of the program to be fixed: DWM Compositing Rendering Demo
· Name of the vendor for this program: DWM Compositing Rendering Demo
· Program file location: 
C:\Program Files\StockViewer\DWM Compositing Rendering Demo.exe

5. Compatibility Modes 창에서 Compatibility Modes에서 None을 선택하고
“다음” 버튼을 클릭합니다.
[image: ]
6. Compatibility Fixes 창에서 “WinXPSP2VersionLie”을 선택합니다. “다음”을 클릭합니다
[image: ]
7. Matching Information 창에서 설정 항목을 확인 합니다. “마침”을 클릭합니다
[image: ]
8. Database 생성이 완료되었으면 저장 후, 설치 메뉴를 통해서 sdb를 설치합니다. 
[image: ]
9. 메뉴 항목에서 “Option>Show me a Star”를 클릭하면, 정상적으로 동작하는 것을 확인 합니다. 
[image: ]
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DisableDWM
Desktop Window Manager (DWM)는 데스크톱 사용자의 인터페이스에 대한 렌더링, 흐릿해짐 제거 등 Rich Client Interface대한 성능을 개선하는 역할을 수행합니다. 그런데 특정 응용 프로그램의 경우 스크린에 바로 렌더링하는 경우, 예를 들어, 화면이 깨져 보이거나, 색상이 다르거나 하는 등의 호환성 관련 문제가 발생하게 됩니다. 
이러한 장애에 대해서 특정 응용 프로그램이 실행될 때 Desktop Window Manager (DWM)를 일시적으로 비활성화하는 Shim을 제공합니다.
DisableDWMShim을 활용하는 방법에 대해서 살펴 봅니다

1. 이전에 생성한 “FreeMDemos.sdb”파일을 연 다음, 아래 그림과 같이 “Edit Application Fix” 메뉴를 클릭합니다.
[image: ]
2. Program Information 창에서 “다음”을 클릭합니다. 
[image: ]
3. Compatibility Modes 창에서 “다음”을 클릭합니다.
[image: ]
4. Compatibility Fixes 창에서 “DisableDWM”를 추가 합니다.  
[image: ]

5. Matching Information 창에서 “마침”을 클릭합니다. 
[image: ]
6. 수정된 SDB 파일을 저장한 다음, 설치합니다. 
[image: ]
7. 메뉴 항목에서 “Option>Show me a Star”를 클릭하면, 아래 화면과 같이 동작하는 것을 확인 합니다. 
또한 색 구성표가 변경되었다는 메시지를 확인 합니다. 
[image: ]
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FakeLunaTheme
Windows Vista부터 에어로(Aero) 테마를 포함하고 있습니다. 사용자가 적절한 테마를 선택할 때, 특정 응용 프로그램에서는 테마에서 설정된 항목이 아니거나 혹은 Windows XP에서 사용되는 테마도 아닌 값으로 설정되는 장애가 발생하기도 합니다. 
이러한 경우 윈도우 XP의 Luna테마로부터 색상을 적용해주는 Shim을 제공합니다.

FakeLunaTheme Shim을 활용하는 방법에 대해서 살펴 봅니다.
1. StockViewer 응용 프로그램을 실행 한 다음, 메뉴 항목에서 “Mails” 를 클릭합니다.
다음과 같이 아웃룩이 실행되는데, 사용자 인터페이스가 흐릿하거나 번짐 같은 현상이 발생합니다. 
[image: ]
2. Compatibility Administrator 도구에서 아래 그림과 같이 “Fix” 메뉴를 클릭합니다. 
[image: ]
3. “Create new Application Fix”창에서 다음과 같이 입력한 다음, “다음”을 클릭합니다. 
[image: ]
· Name of the program to be fixed: OLAF
· Name of the vendor for this program: OLAF
· Program file location: 
C:\Program Files\StockViewer\OLAF.exe

4. Compatibility Modes 창에서 Compatibility Modes에서 None을 선택하고, “다음” 버튼을 클릭합니다.
[image: ]
5. Compatibility Fixes 창에서 “FakeLunaTheme”을 선택합니다. “다음”을 클릭합니다
[image: ]
6. Matching Information 창에서 설정 항목을 확인 합니다. “마침”을 클릭합니다
[image: ]
7. Database 생성이 완료되었으면 저장 후, 설치 메뉴를 통해서 sdb를 설치합니다. 
[image: ]
8. 메뉴 항목에서 ““1” 를 클릭하면, 정상적으로 동작하는 것을 확인 합니다. 
[image: ]


이상으로 호환성 관련해서 발생할 수 있는 여러 항목 들 중에서 일부 항목에 대해서 보다 세밀하게 살펴 보았습니다. 
호환성 관련한 다양한 장애에 대한 정보를 확인 하기 위해서는 먼저 Microsoft Technet 사이트에서는 Application Fix를 참조 하시기 바랍니다 .이 사이트에서는 Application Fixes와 이 Fixes를 적용하기 위한 장애에 대해서 상세히 설명하고 있습니다. 
아래 사이트를 참고 하시기 바랍니다. 
http://technet.microsoft.com/en-us/library/cc722305(WS.10).aspx
	(주)프리엠컨설팅
본 가이드를 제작한 ㈜프리엠컨설팅(www.solutionbuilder.co.kr)은 신기술 전도 컨설팅, 솔루션 공급, 온 사이트 및 온라인 교육서비스를 통해 고객에게 최신의 정보기술 서비스를 제공하는 전문 서비스 파트너입니다.
[image: ]

주요 서비스 안내
· MSstudy(http://www.msstudy.co.kr)
개인이나 기업이 마이크로소프트의 새로운 제품이나 기술 습득을 통해 경쟁력을 확보할 수 있도록 MSSTUDY에서는 관련 제품이나 기술에 대한 정보를 온라인 동영상으로 제공해 드립니다. 
[image: http://new.msstudy.co.kr/images/company/business_middle.gif]

· FAM(팸) 서비스는 FreeM Technical Advisor & Maintenance의 약자로 마이크로소프트의 제품과 기술/서비스에 대해 현업에서 새로운 솔루션에 이를 적용 가능하도록 Technical Advisor 서비스를 제공하며 기 구축된 윈도우 인프라에 대한 최적화 방안 및 유지보수 서비스를 제공합니다.

보다 상세한 내용은 다음 사이트 http://www.msstudy.co.kr/web/company/introduction.aspx를 참조 하시기 바랍니다. 



1. SUA(Standard User Analyzer)를 통한 호환성 장애 확인


2.CA(Compatibility Administrator)를 통한 Shim을 적용


3. 생성된 Shim Databases를  사용자에게 배포함으로
호환성 문제 해결
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